
FIRST LOOK: iLife ’06
Jim Heid reveals the secrets of iPhoto 6, iMovie HD 6, iDVD 6, 
GarageBand 3, and iWeb in this sneak preview of the new  
edition of the book/DVD, The Macintosh iLife ’06.

iPhoto 6:
Better performance, enhanced  
editing, calendars and cards—
and photocasting

iMovie HD 6:
Motion-graphics themes, real-time 
effects, audio enhancements, and 
more sharing options

iDVD 6:
Magic iDVD, widescreen play-
back, enhanced authoring, and 
new themes

GarageBand 3:
Podcasting! New music jingles, 
iChat interviews, movie scoring, 
and more

iWeb:
Put your world on the Web:  
publish Web sites, blogs,  
podcasts, and more on .Mac

New media. 
This month, 
Apple delivers 
iLife ’06, the 
latest version 
of the Mac’s 
personal digital 

media studio. iLife ’06 includes 
new versions of iPhoto, iMovie HD, 
iDVD, and GarageBand, as well as 
a brand-new program: iWeb, 
which enables you to publish Web 
sites through Apple’s .Mac service.

iLife ’06 will be included with  
all new Macs, and will also be 
available separately for $79.  
iLife ’06 requires Mac OS X 
10.3.9 or later (some iMovie and 
GarageBand features require 
version 10.4.4).

About this Booklet

This booklet is a sneak preview of 
the next edition of my book and 
instructional DVD, The Macintosh 
iLife ’06. I’ve worked extensively 

with iLife ’06, and the book 
excerpts shown here highlight 
some of the suite’s best new 
features. Printed inside are 14 
pages from the next edition of my 
book, and I’ve thrown in 
additional details about iLife ’06 
along the way.

If this booklet whets your 
appetite, please see the back 
cover for details on how to order 
The Macintosh iLife ’06 at a hefty 

discount. The back cover also has 
details on The Digital Hub, my 
new podcast—produced using 
GarageBand 3—that covers iLife 
and digital media topics.

Now turn the page to begin 
touring iLife ’06—and the latest, 
completely revised edition of the 
top-selling iLife book.

Jim Heid



RSS is YACA: yet another computer 
acronym. Some say it stands for really 
simple syndication while others main-
tain it stands for rich site summary. 
It doesn’t matter. Just as you don’t 

need to know what DVD stands for in 
order to create or play one, you don’t 
need to know what RSS stands for to 
enjoy its benefi ts.

What Does RSS Stand For?

Publish and Subscribe to Photocasts

Keep friends and family current with your favorite photos by publishing 
photocasts of your favorite iPhoto albums. Use an optional password to 
keep your photos private if you like.

Know someone who’s published a photocast? Use iPhoto to subscribe to it. 
The remote photos appear as though they were stored on your Mac, and 
when the photocast is updated, the latest photos appear in your iPhoto. 
It can be a lot more fun than emailing photos back and forth.

Create Your Own Blog

Create an online journal: a vacation travelogue, a diary, or daily tips for 
your business clients. Create it in iWeb, then publish it via Apple’s 
.Mac Internet service. iWeb automatically creates an RSS feed for you, 
enabling others to subscribe to your blog.

Publish Audio and Video 
Podcasts

Use GarageBand and iMovie HD to create 
audio or video podcasts, then use iWeb to 
publish them via Apple’s .Mac service so that 
others can subscribe to them.

Throughout this book, look for  for information specifi c 
to RSS. And don’t forget to subscribe to the feed for this 

book’s companion site at www.macilife.com

Introducing iLife
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Subscribe to Podcasts

A new kind of Internet radio program, 
the podcast, is all the rage. iTunes is 
your gateway to thousands of podcasts. 
When you subscribe to a favorite pod-
cast, iTunes downloads new episodes 
for you whenever they become available.

It’s no secret that the Internet is a great 
way to stay current—with news, family, 
and anything else you fi nd interesting.

A relatively new Internet technology 
makes it even easier to stay current with 
subjects of interest. It’s called RSS, and it 
allows you to subscribe to information, 
called feeds, from Web sites and other 
Internet sources.

Say your hometown newspaper is called 
The Banner, and you’re interested in keeping 
tabs on it. If the newspaper provides an RSS 
feed, you can subscribe to the feed using the 
latest versions of Apple’s Safari browser or a 
separate newsreader program, such as 
NetNewsWire (www.ranchero.com).

After you’ve subscribed to a feed, it’s 
updated at regular intervals—for example, 
every 30 minutes in Safari. Want to see 
what’s new in the hometown? There’s no 
need to go The Banner’s home page. Simply 
check your RSS feed in Safari. RSS brings 
the news to you.

What does all this have to do with 
iLife? Apple has built RSS into several of 
the iLife programs. As a result, you can 
subscribe to audio content, you can publish 
and subscribe to photos, and you can create 
Web journals (called blogs) to which others 
can subscribe.

I’ll cover the details behind RSS and 
how it relates to iLife ’06 throughout this 
book. Here’s an overview of how iLife ’06 
and RSS work together to keep you current.

iLife Keeps You Connected
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New connections. There’s big 
news across iLife ’06, and much 
of it deals with the Internet. And 
with some of the hottest Internet 
trends, at that: podcasting, 
blogging, and the convenient 
exchange of information made 
possible by RSS.

Podcasting is transforming radio 
by giving a voice to anyone with a 
microphone and by enabling 
broadcasters to reach their 
audiences in new ways. iTunes 
lets you find and subscribe to 
podcasts. And as I describe later 
in this booklet, GarageBand 3 
makes it easier than ever to 

create them, while iWeb makes 
publishing them effortless.

Blogging is also red hot. A blog is 
simply a frequently updated Web 
journal—a personal diary, an 
ongoing vacation travelogue, a 
collection of rants and raves, or a 
source of news and information 
for customers. iLife ’06 includes 
a new program, iWeb, that makes 

it easy to create, maintain, and 
publish a blog through Apple’s 
.Mac Internet service.

Then there are photos, which 
everyone likes to share. iPhoto 6 
takes Internet photo sharing to 
the next level. Add photos to an 
album, then publish that album as 
a photocast. Other iPhoto 6 users 

can subscribe to that album, and 
have it updated at regular 
intervals. And your friends who 
use Windows? They can join in, 
too—any RSS newsreader can 
subscribe to a photocast.

iMovie HD 6 also gains new 
Internet smarts. You can assign 
Web addresses (URLs) to 
markers, enabling your movie’s 
viewers to go to specific Web 
pages as your movie plays back.

 

You can also use iMovie HD 
together with iWeb to prepare 
and publish a movie as a video 
podcast.

 

Your world is getting wider. iLife 
’06 helps keep you connected, 
and you’ll find all the details in 
The Macintosh iLife ’06 and its 
companion DVD. And of course, 
on its companion Web site,  
www.macilife.com.

Reviewers rave:

Jim Heid has 
been writing and 
teaching about the 
iLife applications 
for quite a while, 
and his expertise 
is visible on every 
page. The DVD will 
appeal to those 
who learn best 
by watching as 
opposed to read-
ing. I watched 
the entire DVD, 
and was again 
impressed by the 
completely profes-
sional presenta-
tion and useful 
content...The best 
all-around book on 
iLife that I’ve read.

—Tim Robertson, 
mymac.com
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Fill the screen. iPhoto 6 brings 
improvements across the board, 
including full-screen editing and 
photo comparisons, described 
above.

iPhoto 6 is also a bigger digital 
shoebox. Apple has significantly 
revamped the internal database 
that iPhoto uses to store photos. 
As a result, iPhoto 6 can store in 

the neighborhood of 250,000 
photos—ten times its prior 
capacity. And it opens and displays 
those photos faster than before.

To help you navigate vast 
libraries, iPhoto 6 introduces a 
scroll guide—as you scroll, a 
see-through panel shows dates, 
roll names, and other important 
information.

And for the first time, iPhoto 
doesn’t require you to store all your 
photos in its library. While it’s still 
most convenient to work this way, 

if you already have a photo filing 
system set up on your hard drive, 
you can have iPhoto simply point to 
your original photo files instead of 
duplicating them in its library.

Photocasting is another new 
iPhoto 6 feature. Publish any 
album via Apple’s .Mac service, 
and anyone with iPhoto 6 or a 
newsreader program can 
subscribe to it and get updates. 
iPhoto 6 users who subscribe can 
print photos, use them in slide 
shows and books, and more.  
You can also assign an optional 

password to control who gets to 
subscribe to an album.

iPhoto 6 also lets you apply more 
effects to your photos. The new 
Effects panel puts you one click 
away from eight effects, which 
you can combine.

What do you do once you’ve 
polished your photos? Publish 
them.

When you’re editing and enhancing a 
photo, it’s often helpful to see the big pic-
ture—that is, to display your photo at as 
large a size as possible. When you go big, 
it’s easier to perform color and exposure 
adjustments and to fi nd fl aws that need 
retouching.

The full-screen editing view in iPhoto 6 
gives you a picture window into your pic-
tures. Click the Full Screen button, and 
your Source list and most of iPhoto’s other 
buttons and controls step aside to make 
room for your photos. You can free up even 
more screen space by hiding the toolbar at 
the bottom of the screen and the small 
photo thumbnails along the top.

If you prefer to use full-screen view for 
all your editing tasks, use iPhoto’s 
Preferences command to always have pho-
tos open in full-screen view; see page 344.

Full-screen view teams up nicely with 
another new iPhoto 6 feature: the ability 
to compare two or more photos in order to 
fi nd the best shot in a series. You can dis-
play two or more photos side-by-side and 
even edit them.

It’s worth noting that you can also 
compare photos in iPhoto’s standard edit 
view and in the editing window (see page 
340). But as you can see on the DVD, 
because full-screen view maximizes your 
screen space, it’s the best place for your 
photo-comparison sessions.

The Big Picture: Full-Screen Editing
Comparing Photos
It’s always smart to take more than one version of an important 
shot—to experiment with different exposure settings or to simply 
increase your chances of capturing that perfect smile.

After you’ve imported those multiple variations into iPhoto, 
compare the photos to fi nd the best one of the bunch.

To compare photos

In edit view. If you’re already working in full-screen edit view 
(opposite page), click the Compare button ( ). iPhoto loads 
the next photo and displays both side-by-side.

When you click a different thumbnail, its photo replaces the selected 
photo (in this example, the one on the right). To compare more 
than two photos, 1-click on their thumbnails. (If you don’t see the 
thumbnails, choose Show Thumbnails from the View menu.)

To remove a photo from the 
comparison, click the .

You can also move to the next or previous photo by clicking the 
arrow buttons or by using the arrow keys on your keyboard.

When browsing. You can also set up a comparison before enter-
ing edit view. Select the photos fi rst, then click the Full Screen 
button ( ). For a review of ways to select photos, see page 337.

iPhoto and Digital Photography
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See how to maximize your screen.
Editing in Full-Screen View

Full-Screen Editing
Use full-screen view to compare photos 
or scrutinize a photo for editing (or just 
when you want to show it off).

As the sidebar below describes, you can 
customize the full-screen view to free up 
even more precious pixels for your pictures.

Switching to 
full-screen view

To edit a photo in full-screen view, select 
the photo and then click the Full Screen 
button ( ).

Similarly, if you’re already in the standard 
edit view, you can switch to full-screen 
view by clicking the same button.

You can view and edit photo information 
in full-screen view; click the Info button to 
display the Information panel shown here.

To display a different 
photo, click its thumb-
nail. To compare pho-
tos, 1-click on each 
thumbnail.

If you’ve zoomed in on 
a photo, the Navigation 
panel appears. Drag the 
rectangle to quickly pan 
around the zoomed 
photo.

To exit full-screen view, 
click the  button. 
Note: You can also exit 
full-screen view by 

pressing your keyboard’s Esc key, 
although this discards any edits you made.

Comparing 
Photos

You can compare up to eight pho-

tos. Select the photos and then 

click the Full Screen button, or, 

if you’re already in edit view, 

1-click on the thumbnail image 

of each photo that you want to 

add to the comparison.

The more photos you compare, 

the smaller each one appears, 

so you may not want to compare 

eight nearly identical photos on 

a Mac with a small screen.

To remove a photo from a com-

parison, deselect the photo by 1-

clicking on its thumbnail image. 

All of iPhoto’s editing features 
are available when you’re 
comparing photos.

Full-screen view

To free up more screen space, 

hide the thumbnails that iPhoto 

normally displays along the top 

of the screen. Choose View > 

Hide Thumbnails or press 

Option-1-T.

To see the thumbnails again, 

move the mouse pointer toward 

the top of your screen, and they’ll 

glide down into view. Or, restore 

the thumbnail display by using 

the View menu or Option-1-T.

Want to free up every bit of 

screen space? Hide the toolbar 

at the bottom of the screen, too: 

choose View > Hide Toolbar.

To have the toolbar pop back into 

view, move the mouse pointer 

near the bottom of your screen.

Don’t forget the shortcut 
menu. You’re in full-screen view 

and you’ve hidden the toolbar. 

You can still access most edit-

ing functions by using the short-

cut menu: Control-click 

anywhere within the photo, then 

choose a command from the 

shortcut menu.

By hiding both the thumbnails 

and the toolbar and then using 

the shortcut menu, you can take 

full advantage of every pixel on 

your display.

Tips for Comparing Photos and Full-screen Editing

iPhoto and Digital Photography
The Big Picture: Full-Screen Editing
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Reviewers rave:

The book is 
attractively laid 
out with plenty of 
pictures, sidebars 
and glossaries. 
But what really 
distinguishes 
Heid’s manual 
is the accom-
panying DVD, in 
which Heid gives 
a series of video 
tutorials. It’s like 
taking a class at 
an Apple Store 
without having to 
leave the house. 

—Leander 
Kahney, Wired 
News and author, 
The Cult of Mac
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See and be seen. iPhoto 6 gives 
you more ways to share your 
photos. Besides photocasts, you 
can use iWeb to publish photo 
albums on Apple’s .Mac service.

Prefer hard copy? Create photo 
calendars as described above—
they’re spectacular. Or design and 
order greeting cards and postcards 
in any of numerous styles.

Your photo appears 
on the front of the 
card, and a text 
message of your 

choosing appears on the inside. 
Greeting cards measure 5 by 7 
inches. In quantities of one to 24, 
they cost $1.99 each. Order 25 
to 49 cards for $1.79 each; 50 or 
more cards are $1.59 each.

 
 

 
As for postcards, they measure  
4 by 6 inches and cost $1.49 

(1–24), $1.29 (25–49), or $.99 
(50 or more). The back of the 
postcard can contain a full block 
of text or you can use a standard 
postcard-mailing format, complete 
with a “place postage here” box.

Greeting cards and postcards are 
printed on a heavy card stock and 
include matching envelopes.

And books? They’re still available 
in iPhoto 6. Apple has upped the 
print resolution to 300 dots per 
inch, yielding sharper photos. And 
in a new twist, you can view a 
book as a temporary slide show: 
just display the book, and then 

click the Play button. Each page 
appears as its own “slide,” 
complete with any text captions 
you added.

Prefer to do your own printing? 
There’s good news here, too: it’s 
easier to print full-page borderless 
photos. Select the Zoom and Crop 
check box in the Print dialog box, 
and iPhoto enlarges your image as 

needed to fit the proportions of 
the paper you’re using—no more 
ugly white borders.

 
 

Other goodies: You can create 
smart albums based on camera 
EXIF data. You can have iPhoto 
save raw images as 16-bit TIFFs 
instead of as JPEGs. You’ll find 
full details on these and other 
iPhoto 6 enhancements in The 
Macintosh iLife ’06.

See how to create a photo calendar.
Creating a Photo Calendar
Tips for Making Calendars

Step 4. Specify calendar details, then 
click OK. Here’s your fi rst big opportunity 
to customize the calendar so it contains 
dates that are important to you.

How many months? Type a number 
between 12 and 24 or click the arrow 
buttons.

Veterans Day? Deepavali? Queen’s Day? 
Specify your preferred national holiday 
list, or choose None.

Use iCal? To include iCal dates in your cal-
endar, check the box next to the calendar.

Store birthdays in Mac OS X’s Address 
Book program? You can automatically 
include them in your calendar.

To replace this place-
holder text with your own, 
select the text and type.

View the next or previous 
month.

Zoom in on a page for 
proofreading and fi ne 
tuning.

To add text to a date, click its name and 
type the text in the box that appears. As 
page 314 shows, you can also add pho-
tos and captions to specifi c dates.

Step 5. Drag photos into your calendar’s 
pages, or click the Autofl ow button ( ).

Switch between viewing calendar thumb-
nails (shown here) or photos you haven’t 
yet placed in the calendar (page 314).

Switch views and perform various design 
tasks (page 312).

Layout for the lazy: click Autofl ow, and 
iPhoto adds photos for you (page 310).

Step 6. Step through each month of the 
calendar, fi ne-tuning designs and adding 
custom date items as desired (see the 
following pages for details and tips).

You can adjust a photo’s position within 
its frame.

Each calendar design offers a variety of 
photo arrangements, some providing 
space for captions.

Step 7. Click  and pay using 
your Apple ID (page 13).

When? Choose a starting month and a year.
iPhoto and Digital Photography

Creating a Photo Calendar
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Store-bought calendars can be gorgeous, 
but they lack a certain something: your 
photos. Why build your year around some-
one else’s photos when you can build it 
around your own?

With the calendar-publishing features 
in iPhoto 6, you can create calendars con-
taining as few as 12 months and as many 
as 24. Choose from numerous design 
themes, each of which formats your photos 
and the dates of the month in a different 
way. Then drag photos into your calendar, 
fi ne-tuning their cropping along the way, 
if you like.

Commercial calendars usually have 
national holidays printed on them. Yours 
can, too—and then some. You can add 
your own milestones to your calendar: 
birthdays, anniversaries, dentist-appoint-
ment reminders. If you use Apple’s iCal 
software (page 320), you can even import 
events from iCal and have them appear in 
your calendar.

When you’re fi nished, click the Buy 
Calendar button. iPhoto transfers your 
photos and design to Apple’s printing 
service, which prints your calendar 
and ships it to you. A 12-month 
calendar costs $19.99. Each addi-
tional month is $1.49.

And you don’t have to post-
pone your foray into calendar 
publishing until next year. You 
can have your calendar begin 
with any month you like.

Creating a Photo Calendar
The Big Picture
Step 1. The most effi cient way to create a calendar is to fi rst 
add the photos you want to publish to an album.

Tip: To further streamline your layout work, sequence the pho-
tos in the album in the same general order in which you want 
them to appear in the calendar.

Step 2. Click the Calendar button ( ). The Themes panel 
appears.

Step 3. Choose a theme (click its name to see a preview of its 
design), then click Choose Theme.

iPhoto and Digital Photography
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Reviewers rave:

Jim has done a 
great job distilling 
these feature-rich 
applications down 
to their essence... 
The included DVD 
is well done and 
augments the book 
with a step-by-
step explanation 
that you can follow 
visually.

—J.H., on 
Amazon.com
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Now premiering in real time. 
I’ve already described the 
enhanced Internet features in 
iMovie HD 6. What else is new in 
iLife’s video editing tool? You can 
read about one enhancement 
above: built-in themes for creating 
elegant motion graphics.

Also new in iMovie HD 6 is the 
ability to display effects and 

transitions in real time—without 
having to render them first, thanks 
to the Core Video technology in 
Mac OS X. Instead of squinting at 
a little thumbnail-sized preview, 
you can see previews of effects 
right in the iMovie HD monitor. 
Ken Burns has never been easier 
to work with.

And speaking of OS X, iMovie HD 
takes advantage of Quartz 
Composer, a technology built into 
Mac OS 10.4.4. iMovie HD 6 

includes a glittering array of visual 
effects that tap into Quartz 
Composer. While these effects 
require Mac OS 10.4.4, iMovie 
HD’s standard effects still work 
on earlier OS versions.

iMovie HD 6’s titling features are 
also improved. Titles now render 
with sub-pixel accuracy and field 
blending, improving quality and 

reducing the distracting shimmer 
that could occur with earlier 
iMovie versions.

Sound also gets more attention in 
iMovie HD 6. A new Audio FX 
panel taps into Mac OS X’s Core 
Audio technology to provide many 
audio effects, including a graphic 
equalizer, reverb, and a noise-
reduction filter that you can use 

to clean up wind and camera 
noise. And with the Pitch Changer 
effect, you can make your 
relatives sound 
like a family of 
chipmunks—
or monsters.

When you’re 
editing, it’s 
often useful to 

be able to refer to (and borrow 
from) other projects you’re 
working on. iMovie HD 6 is the 
first iMovie version that lets you 
have multiple projects open at 
once. You can have up to 10 
projects open, and you can even 
copy clips between projects by 
dragging. (Be sure you have 
plenty of disk space: copying a 
clip makes a duplicate of it.)

Play the preview and control 
whether the preview plays 
over and over (loops).

To view specifi c parts of the 
theme element, drag the motion 
playhead left or right.

Step 1. Choose a theme fam-
ily from the pop-up menu.

Step 2. Click the theme ele-
ment you want.

Hide (or show) the preview in 
the monitor.

Hide (or show) the Drop 
Zones panel.

Step 3. If the element you’ve 
chosen provides boxes for title 
text, type the text.

See how to work with iMovie themes.
Working with Movie Themes

You can add theme elements 
as you work on a movie, or 
wait until after you’ve com-
pleted other editing tasks. 
Tip: If you’re using timeline 
bookmarks (page 302) to 
align clips or time them to 
music or other audio, you 
might want to add theme ele-
ments as you work to avoid 
disrupting your movie’s timing.

To add a theme element, click 
the Themes button.

Using Theme Elements

Step 4. Drag media to the 
boxes in the Drop Zones 
panel. To add photos from 
iPhoto, click the Media button 
to display the media browser.

To add a video clip, drag it 
from the Clips pane or from 
the timeline. You can also 
drag it from these locations in 
other open iMovie projects.

Tip: For best results, be sure 
that the orientation of a photo 
or video clip matches that of 
its drop zone. For example, if 
the drop zone is vertically ori-
ented, use a vertically ori-
ented photo in it. Otherwise, 
the photo or clip may appear 
strangely cropped.

To replace an item in a drop 
zone, simply drag a new item 
to the drop zone. To remove 
an item from a drop zone, 
select the drop zone and 
press the Delete key.

Step 5. Click  or the 
check mark ( ) in the Preview.

iMovie HD renders the clip 
and adds it to the timeline. 
You can work with the clip as 
you would any other video 
clip: trim it, add effects, and 
so on.

For some ideas to get your 
creative juices fl owing, see 
the tips on the following 
pages.

iM
ovie HD
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Watch any TV show, and you’ll see that 
video producers rely on a standard vocabu-
lary of visual building blocks—elements 
that identify major portions of the show 
and serve to tie scenes together.

A show opens with a fl ashy graphic 
containing text and imagery. The fi rst seg-
ment is introduced with another graphic. 
A city scene appears, and a superimposed 
lower-third graphic identifi es the scene. 
One scene completes, then a short bumper 
appears as a visual separator before the 
next scene begins. These visual seasonings 
are sprinkled throughout the rest of the 
show, and then the credits roll.

These elements of imagery are often 
called motion graphics, and for good reason. 
Instead of being static text and graphics, 
they employ slick animation that adds 
visual appeal. Words don’t just fade in and 
fade out; they glide into view, superim-
posed over elegant, moving backgrounds.

It’s the kind of eye candy we’re used to 
seeing on TV, and now you can serve it up 
in your productions with the video themes 
built into iMovie HD 6. Choose a theme, 
then customize it by adding photos or mov-
ies to its drop zones. When you’re done, 
iMovie HD renders the clip and adds it to 
the timeline.

Themes can do more than just add 
sizzle to your movies. They can also help 
you add structure: by employing themes, 
you can frame the elements of your movie 
and tell a better story.

Important: To use iMovie HD 6’s themes, you 
must be running Mac OS X 10.4.4 or a later ver-
sion, if available.

Adding Sizzle and Structure with Themes
The Elements of a Theme
iMovie HD includes four sets of themes, and many have counter-
parts in iDVD, iPhoto, and iWeb. Each theme provides one or 
more drop zones into which you can add photos and video clips. 
Most theme elements also provide an area where you can type 
some text.

Each set of themes provides its own mix of visual elements, but 
all of the sets have some common ground. Here’s a look at that 
common ground from the perspective of the Travel theme.

Opener
Displays a montage of photos or movies, 
culminating with a title. Use the opener to 
begin your epic.

Chapter
A shorter motion graphic that’s ideal for 
separating major scenes of a movie. 
Some themes provide more than one 
chapter design.

Lower Third
True to its name, a lower third occupies 
the lower portion of the screen; it’s ideal 
for identifying the people or places in a 
shot.

Bumper
A bumper is also ideal for separating 
scenes. In some themes, bumpers display 
imagery only, with no text. Some themes 
have multiple bumper designs.

Credits
You know what they are. Some themes 
provide more than one credits design.

iMovie HD: Making Movies
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Readers rave:

This combination 
of DVD and book 
suits my learning 
style well. What 
a refreshing style 
of presentation!

—E.B.

 
Jim does a 
superb job of 
anticipating 
the iLife users’ 
questions as 
they follow along 
with his guided 
instructions and 
his explanations 
of the various 
features. It is 
almost as good 
as having a live 
person right there 
along your side.

—J.Z., on 
Amazon.com

And just for fun, use iMovie HD’s 
new time-lapse feature to create 
time-lapse movies: roses 
blooming, clouds racing across 
the sky, piano recitals taking only 
three minutes.
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Go wide. The star of the show 
in iDVD 6 is Magic iDVD, 
described above.

But there’s a strong supporting 
cast, too, and it begins with a 
set of ten new menu design 
themes. Each theme includes 
submenu designs for chapters 
and “extras,” such as slide 
shows. And all themes are 

available in widescreen (16:9) 
format, as well as conventional 
(4:3) format.

iDVD 6 is the first version of 
iDVD to support widescreen DVD 
burning. If you have a widescreen 
TV, you can burn DVDs that  
take advantage of every one of 
those pricey pixels. (Given the 
still-developing world of high-

definition DVD standards, the 
DVD content itself is delivered in 
standard definition.)

iDVD 6 sports a new look and 
feel. The drawer that slid out of 
the left side of the iDVD window 
is gone; in its place are a set of 
panes that appear on the right-
hand side of the window.

As in earlier versions, iDVD’s 
menu themes have drop zones 
into which you can add photos 
and movies. To simplify the 

process of adding items to drop 
zones, iDVD 6 provides a Drop 
Zones panel, which also has 
handy options for customizing the 
DVD’s menu background and 
background audio.

 

Customizing opportunities abound 
in iDVD 6. More button designs 
are available, for example, and 
you can mix and match multiple 
buttons styles on a single menu. 

Please do so tastefully or risk 
offending the menu-design police.

And slide shows? They’ve always 
been a great way to present 
photos, but the DVD specification 
limits a slide show to 99 images. 
iDVD shatters this limit by 
enabling you to create slide shows 
containing thousands of images. 
(Food and water not included.)

See how to make DVD magic.
Making a Magic iDVD

Here’s a look at how Magic iDVD 

does its design. And remember, 

you aren’t locked into its magical 

decisions. You can customize 

anything in the projects that 

Magic iDVD creates.

Main title. The name you type 

into the DVD Title box becomes 

the title of your main menu.

Submenus. Your DVD’s main 

menu will contain buttons that 

link to submenus for playing the 

DVD’s movies and slide shows.

Chapter menus. Similarly, if 

you add a movie containing 

DVD chapter markers, you get a 

submenu for accessing those 

chapters. For themes that have 

separate chapter menu designs 

(all of the new iDVD 6 themes 

do), iDVD uses the chapter menu 

design for the chapter menu.

Drop zones. iDVD automatically 

adds movies to the drop zones 

of whatever menu theme you 

choose. If your DVD contains 

only slide shows, iDVD uses 

photos from the slide shows for 

the drop zones.

Behind the Magic

Tips: You can also drag movies directly 
from folders on your Mac’s hard drive. 
(To have iDVD list movies from other 
folders in its media browser, use the 
Preferences command as described on 
page 368.)

Need to add multiple movies? Simply 
Shift-click or 1-click on each one to 
select the movies, then drag them as a 
group, as shown on the opposite page. 
When you release the mouse button, 
each movie appears in its own drop box.

Step 5. To add a slide show to the 
DVD, drag photos into the photos drop 
boxes. Each box represents a different 
slide show.

Tips: You can drag albums from iPhoto, 
or folders of photos from your hard drive 
or a CD. If you like to overwork, you can 

drag individual photos to a drop box, one 
at a time. You can also combine 
approaches. For example, you can drag 
an entire album to create a slide show, 
then drag individual photos to that slide 
show’s drop box to add them to the show.

And just as you can add multiple movies 
at once, you can create multiple slide 
shows at once. Shift-click or 1-click on 
each album in the Photos media browser, 
then drag the albums as a group. Each 
album becomes its own slide show.

Step 6 (optional). To add music to a 
slide show, drag an audio fi le from the 
Audio media browser (or elsewhere on 
your hard drive) to the slide show.

A speaker icon appears on the slide 
show’s thumbnail to indicate that it has a 
soundtrack.

Step 7. Preview or fi nish up.

Check your work. To preview the DVD, 
click the Preview button. When you exit 
preview mode, you return to the Magic 
iDVD window.

Ready to bake. If you’re happy with the 
job Magic iDVD has done, click the Burn 
button. iDVD creates a project containing 
your content, then immediately switches 
into burn mode. (For burning details, see 
pages 370–377.)

Further refi nement. If you want to 
refi ne the project—for example, to cus-
tomize some menus or refi ne your slide 
shows—click the Create Project button. 
iDVD creates a project that you can cus-
tomize using the techniques described 
throughout this section.

iDVD
: Putting it All Together

M
aking a M

agic iDVD
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When you want to create a DVD in a 
hurry, use the Magic iDVD feature that 
debuted in iDVD 6.

Magic iDVD presents you with a single 
window containing a list of menu themes, 
a set of drop boxes for holding movies and 
photos, and a media browser for accessing 
your audio, photos, and movies.

Choose a theme, then drag movies into 
the drop boxes. To create DVD slide 
shows, drag photos to the drop boxes. 
Drag an entire album from iPhoto or 
build a slide show one photo at a time by 
dragging individual photos into the same 
box. Want a music soundtrack for a slide 
show? Drag an audio track into the slide 
show’s drop box.

When you’re done, preview your work 
by clicking the Preview button and using 
iDVD’s standard preview features (page 
358). Then click the Burn or Create 
Project buttons, and iDVD builds your 
project for you, even creating chapter 
submenus for movies containing DVD 
chapters (page 362).

Magic iDVD may be all you need for 
many projects. And if you need to custom-
ize or enhance the DVD it creates, you can 
bring the rest of iDVD’s authoring features 
to bear. Indeed, Magic iDVD is a great 
way to rough out a project that you plan to 
refi ne later.

Here’s how to make DVD magic.

Making a Magic iDVD
Magic iDVD versus OneStep DVD

iDVD now provides two ways to go from zero to DVD with very 
few steps. Which method should you use, and when?

When to go OneStep. Use OneStep DVD when you want to burn 
just one movie to a DVD and you don’t need navigation menus. 
When you use OneStep DVD, you don’t have the opportunity to 
customize menu designs—there aren’t any. As page 380 
describes, OneStep DVD creates an autoplay, or kiosk-mode, 
DVD: the disc begins playback as soon as you insert it into a 
computer or DVD player. 

When to go Magic iDVD. Use Magic iDVD when you want navi-
gation menus and more than one piece of content on your 
DVD—for example, a couple of movies and some slide shows.

To Make a Magic iDVD

Step 1. Choose File > Magic iDVD. 

Step 2 (optional). Edit the DVD title.

Step 3. Choose a theme for the DVD by clicking one of the 
theme thumbnails. (To access additional themes, use the pop-up 
menu above the row of thumbnails.)

Step 4. To add video to the DVD, click the Movies button in the 
media browser, then drag one or more movies into the drop boxes.

iDVD: Putting it All Together
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Reviewers rave:

Jim Heid has 
created the best 
“how to” book I 
have seen and 
considering it 
comes with a two-
hour companion 
DVD, it is indeed 
a bargain at the 
cover price.

—Arthur Arnold, 
Alaskan Apple 
Users Group

Jim Heid...has 
clearly spent a 
great deal of time 
learning the soft-
ware and search-
ing out its hidden 
treasures.

—S.S., on 
Amazon.com

You can also have photo titles and 
comments superimposed over 
your images: click the Settings 
button, then check the Show 
Titles and Comments box. It’s a 
slick way to annotate your 
images. You can also import 
slides from Apple’s Keynote 
presentation software.
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Now podcasting. Many podcast 
producers have already been using 
GarageBand to produce their 
shows. If you’re in this group, you’ll 
be even happier with GarageBand 
3’s new podcast production 
features, described above.

New to podcasting? Test the 
waters using the built-in 
microphone that your PowerBook, 

iBook, or iMac provides. Use 
GarageBand 3’s Speech Enhancer 

audio filter to optimize the sound 
from these mikes.

GarageBand 3 is about more than 
just podcasting, of course. It’s 
also about movie scoring: you can 
send an iMovie project or other 
QuickTime movie to GarageBand, 
and add narration, music, and 
sound effects. GarageBand 
includes a large collection of foley 

sound effects, such as footsteps 
and doors.

When you’re finished, send the 
final movie to iDVD, export it as a 
video podcast, or export it as a 
QuickTime movie. GarageBand 
mixes down the tracks you’ve 
added to a pair of stereo tracks 
and adds them to the movie as 
an additional set of audio tracks.

Apple also tuned GarageBand’s 
interface. For example, the 
floating Track Info window is 
replaced by a panel that appears 
along the right side of the 
GarageBand window.

And there are other tweaks large 
and small. Large: a song can be 
up to 1999 measures—double 
the previous limit. Small: a real 

instrument region can follow its 
original tempo rather than that of 
the song.

GarageBand can also save an 
audio preview along with a 
project. This allows you to 
preview a GarageBand song using 
the media browsers in the other 
iLife applications. In a related 
vein, you can export GarageBand 

projects in a compact form that 
uses less disk space.

If you want to go global, check 
out the latest addition to Apple’s 
Jam Pack library: World Music. 
Available for $99, it contains over 
3000 loops and a vast collection 
of software instruments—sitars, 
pan flutes, Chinese violins, a 

Listen in on podcasting.
Creating a Podcast

When you create a new pod-
cast, GarageBand gives you a 
standard set of tracks for 
common elements. You can 
customize these tracks and 
add more (page 322).

Use the podcast track to view 
and edit marker regions—
for example, to synchronize a 
piece of artwork with a spe-
cifi c section of your show 
(page 320).

Control how a track’s volume 
is affected by the ducking 
feature. Click the down-point-
ing arrow for a background 
music track (page 310).

Preview the appearance of 
your enhanced podcast as it 
plays back (page 320).

Drag an image here to add 
episode artwork to your pod-
cast (opposite page and 
page 325).

Create, edit, and manage the 
markers in your enhanced 
podcast (page 324).

Switch between displaying 
the Media browser (opposite 
page) and Track Info panel 
(page 319), where you can 
refi ne your sound.

Specify episode information, 
which appears in iTunes and 
iWeb (page 390).

GarageBand: From
 M

usic to Podcasts
Creating a Podcast at a Glance
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I’ve already described how you can use 
iTunes and your iPod to listen to podcasts of 
all kinds (pages 46–47). With GarageBand 3, 
you can go from listener to producer. 

GarageBand 3 turns your Mac into a 
radio studio—with broadcast engineer. 
Connect a microphone to your Mac or use 
the built-in mike that some Macs provide. 
You can also use the microphone built into 
Apple’s iSight video camera. GarageBand 3 
contains audio fi lters that optimize the 
sound produced by an iSight or built-in 
Mac mike.

Record your rants, vacation dispatches, 
family interviews—whatever you like. You 
can even record remote interviews with 
iChat users. Your audio is recorded into real-
instrument tracks, so you can edit it using 
the same techniques described on page 309.

Need theme music? Compose your own  
or use one of the many royalty-free music jin-
gles included with iLife ’06. Use the ducking 
feature to have GarageBand automatically 
lower and raise the music volume when you 
start and stop talking—just like the radio.

But don’t stop there. Consider creating 
an enhanced podcast. Add chapter markers 
that enable listeners to conveniently jump 
around through your show. Add artwork 
that appears during playback in iTunes and 
on any iPod that can display photos. And 
add Web URLs that let iTunes users jump 
to specifi c Web pages as your show plays.

When you’re fi nished, send your com-
pleted production to iWeb for publishing 
on the Internet. Here’s how to become a 
podcaster.

Creating a Podcast at a Glance
Pick a Background

Use the loop browser to 
explore and choose from 
more than 100 jingles, 
including many sets that 
provide the same song in 
lengths of 7, 15, and 30 
seconds. You can also 
choose from hundreds of 
sound effects and music stingers—and even use the Musical 
Typing window to play them as you do your show (page 326).

Add Visuals

Use the media browser to 
add photos (page 320) or 
movies (page 322). Use 
the search box to quickly 
locate what you need.

Add Web Connections

Want your listeners to be able to jump to Web pages that relate 
to your subject? Add Web addresses (URLs) to your markers 
(page 325).

GarageBand: From Music to Podcasts
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Reviewers rave:

The beautiful 
color illustrations 
jump out at you, 
making this book 
so enjoyable to 
read and so easy 
to follow at your 
computer.

—Maria Arguello, 
Main Line 
Macintosh User 
Group

This is an extraor-
dinary book! It is 
written in a logical 
fashion with a 
humorous touch.

—P.P., on 
Amazon.com

Soweto choir, a shanai, and many 
more.

The Macintosh iLife ’06 contains 
full details on GarageBand 3 and 
the full Jam Pack collection. And 
because it’s the only iLife book 
that includes a companion 
instructional DVD, you can see 
and hear iLife in action instead of 
just reading about it.
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Your world on the Web. The 
newest member of the iLife 
family, iWeb is a Web publishing 
program that enables you to 
create Web sites containing text, 
photos, podcasts, video podcasts, 
and blogs.

iWeb works together with Apple’s 
.Mac Internet service. When you 
publish blogs and podcasts, .Mac 

themselves are much flashier 
than the .Mac HomePage photo 
albums you may have seen in the 
past. Slide shows appear against 
a black background, with an 
elegant reflection effect below 
each photo. Move your mouse to 
the top of your screen, and a 
thumbnail chooser appears for 
jumping to specific images.

Although iWeb works best with 
.Mac, you can also publish your 
site to a local folder. You might 
take this approach if you want to 
burn a copy of the site to a CD or 
DVD-ROM or serve your site 
using a local Internet provider.

A new iTunes, too  
iLife ’06 includes iTunes 6.0.2. 
The new iTunes can convert video 
files for playback on a fifth-
generation iPod: simply select a 
video that you’ve added to iTunes, 
then choose Convert Selection for 
iPod from the Advanced menu. 
Or, Control-click on a video and 
use the shortcut menu.

The iTunes 6.0.2 window also 
includes what Apple calls the 
MiniStore. As you navigate your 
library, the MiniStore shows 
songs relevant to whatever you’ve 
selected in your library. The 
MiniStore also appears when 
you’re importing music from a CD. 
If you’d prefer to not see it, choose 
Hide MiniStore from the Edit menu.

And that’s iLife ’06 in a nutshell. 
To get the rest of the story, turn 
the page to learn how to buy The 
Macintosh iLife ’06 for 35 percent 
off. And don’t forget to visit my 
book’s companion Web site, 
www.macilife.com, for ongoing 
updates and my new podcast, 
“The Digital Hub.” 

See how to move your media to the Web.
iWeb: Your World on the Web

The site organizer lists 
the sites you create 
and their pages. You 
can create multiple 
sites with iWeb, and 
even move pages 
between sites.

As you create pages, 
iWeb creates a naviga-
tion menu that your 
site’s visitors will use to 
get around. iWeb 
updates your navigation 
menu as you rearrange 
and expand your site.

Create your pages on 
the webpage canvas. 
Drag text and graphics 
around, add and remove 
text boxes and photos, 
type and format text, 
add shapes, and more.

Add photos from 
your iPhoto library or 
another source 
(pages 388–390).

Add a new 
Web page 
(page 376).

Send the site to 
.Mac for all—or only 
some—to see (page 
388).

Add text boxes and 
shapes (pages 380-
382) and refi ne layouts 
(page 385).

Open the published 
version of the site in 
your Web browser.

Add a hit counter to 
count the visitors to 
your site, and an email 
link to allow visitors to 
contact you (page 392).

Open the Media 
browser (right) for 
accessing photos, 
movies, and music.

Open the Adjust 
panel (right) for 
image tweaking, 
such as in iPhoto
(page 390).

Open the Inspector 
(right) for precise 
formatting, linking, 
and more.

iW
eb at a Glance

iW
eb: Your W

orld on the W
eb
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With iWeb, you can put your world on the 
Web. You can create Web sites containing 
text, photos, movies, podcasts, and more. 
iWeb insulates you from Web publishing 
technicalities, such as markup languages 
and servers.

Start by choosing one of the site design 
templates that are built into iWeb. Many of 
those designs have counterparts in other 
iLife ’06 programs. For example, the Travel 
template in iWeb resembles the Travel 
theme in iPhoto, iDVD, and iMovie HD. 
Thus, you can create a Web site about your 
vacation and have it match your iPhoto 
books and calendars, your iMovie video 
travelogue, and the DVD containing your 
video and travel slide shows—a consistent 
visual identity, as the marketers would say.

Each iWeb template provides several 
types of pages, as shown at right. As you 
create a site, you simply add new pages as 
needed to accommodate what you want to 
publish.

Decided on a design? Just add content. 
Replace the placeholder photos and text 
with your own. Use the page design as is, 
or use iWeb’s formatting tools to customize 
it to your own liking. If you’ve used Apple’s 
Pages or Keynote software, you’ll feel at 
home with iWeb’s formatting features.

iWeb also simplifi es creating blogs and 
podcasts. Creating a new blog or podcast 
entry is as easy as creating a new email 
message. iWeb also manages the chores of 
creating archive pages and RSS feeds.

When you’re fi nished, one click sends 
your site to Apple’s .Mac service—and to 
the world.

iWeb at a Glance
A Gallery of Web Pages

Each iWeb template provides six page styles, each aimed at a 
specifi c type of content. Each design has placeholders for text and 
graphics; you can also add additional graphics and text boxes.

Welcome
An introductory home page, ideal for welcoming 
visitors and stating the purpose of your site.

About
A good place to describe yourself, your business, 
your organization—whatever your site is about.

Photos
A photo album, with small photo thumbnails and 
a button for displaying photos as a slide show. 
You can also create a photo page from within 
iPhoto (page 268).

Movie
A page designed to present a QuickTime movie. 
You can also create a movie page from within 
iMovie HD (page 298).

Blog
A page that holds a single blog entry—for exam-
ple, one dispatch from your vacation. You can also 
create a blog entry from within iPhoto (page 269).

Podcast
A page designed to present a podcast episode. 
You can also create a podcast entry from within 
GarageBand (page 334) and a video podcast 
entry from within iMovie HD (page 319).

iWeb: Your World on the Web
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Reviewers rave:

My son...was able 
to use the book 
(and the accom-
panying DVD) to 
learn GarageBand 
in less than an 
hour!

—R.C., on 
Amazon.com

 
Very well written, 
informative, and 
easy to read. It 
was exactly what I 
was looking for.

—J.S., on 
Amazon.com

works behind the scenes to 
create the RSS feeds that will 
enable others to subscribe to your 
content.

As the book 
excerpt above 
shows, iWeb lets you publish Web 
photo albums on .Mac. You can 
view those albums as slide 
shows, and the slide shows 
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Improve your iLife.

Order The Macintosh iLife ’06 Book/DVD
Save 35% off the $34.99 cover price,  
plus get FREE shipping* 
Order the book/DVD now and save 35 percent and get free shipping!*

Visit www.peachpit.com/ilife06 and enter EE-TIPS-GAP2 when asked during 

checkout. It’s that easy. *Domestic U.S. ground shipping only

The Macintosh iLife ’06:
An Interactive Guide to iTunes, iPhoto,  
iMovie HD, iDVD, GarageBand, and iWeb
Published by Peachpit Press in association with Avondale Media

The definitive iLife reference, completely revised and expanded.

Each two-page spread is a 
self-contained tutorial or set of 
tips. Over 400 full-color pages, 
all updated for iLife ’06.

More than two hours of instruction: 
watch as Jim Heid shows you how 
to master iLife ’06.

Music, movies, photos, and Web sites come together before your eyes.

Now entering its fifth edition as the 

definitive iLife reference, The Macintosh 

iLife ’06 is a lavishly illustrated handbook 

and a two-hour instructional DVD that 

combine to create the ultimate digital 

media learning experience.

Jim Heid, a contributing editor of Macworld 

magazine and a veteran voice of the Mac 

world, has been using and teaching the 

iLife applications since their debut. In The 

Macintosh iLife ’06, Heid combines his 

friendly writing style with engaging video 

presentations to bring you insights and tips 

that you won’t find anywhere else.

If you enjoyed this preview of iLife ’06, 

you’ll love his complete, interactive guide—

a completely revised and expanded edition 

of the original Mac digital hub book.

Tune in to “The Digital Hub”
Want more details on iLife ’06? Tune in to “The Digital Hub,” Jim Heid’s  

enhanced podcast dealing with iLife ’06 and digital media topics of all kinds.

To listen and learn more, visit www.macilife.com/podcast


